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1.0 Objective of this document 

This document is to be used to prepare for the practical section of the SIX Repo Ltd 
trading license examination and also as a point of reference when using the CO:RE 
trading platform. There is a separate document for the theoretical part of the 
examination. This is available at: www.six-repo.com > Participation > Traders > Training 
& Examination > Preparatory documentation > Trading on SIX Repo Ltd – Theory 
Preparatory Examination Documentation for Traders. 

2.0 CO:RE trading platform 

SIX Repo Ltd operates the CO:RE trading platform for the settlement of repo 
transactions to ensure and manage liquidity. This platform is only made available to a 
closed group of participants. 

The CO:RE trading platform comprises two separate applications: 

- CO:RE Reference Data GUI 
- CO:RE Trading GUI  

Technical information can be found in the “Participant Section” of the SIX Repo Ltd 
homepage (www.six-repo.com, login required). 

3.0 CO:RE Reference Data GUI 

The CO:RE Reference Data GUI is installed separately from the CO:RE Trading GUI. 

The CO:RE Reference Data GUI allows the following actions: 

- Management of desk administrator accounts 
- Management of user accounts 
- Creation of distribution lists 
- Creation of counterparty agreements 

3.1 User roles 

The following user groups have access to the CO:RE Reference Data GUI:  

- Desk administrator 
- Trading user 

 
 
 

http://www.six-repo.com/
http://www.six-repo.com/
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User role Description Created by 
Desk 
administrator 

Allows the administration and 
capture of desk administrators and 
trading users. 

Desk administrator 
Important: The initial desk administrator 
is always entered by SIX Repo Ltd. 

Trading user Allows the creation and 
management of distribution lists 
and counterparty agreements. 

Desk administrator 

 
Please note: There are further roles with restricted authorizations; details of these can 
be found in the online help of the CO:RE Reference Data GUI. 

Desk administrators and trading users have different logins; as such, the home screen 
has a different appearance. 

3.2 CO:RE Reference Data GUI – Desk administrators 

After logging in as a desk administrator, the following home page is displayed: 

 

3.2.1 Party administration 

The Party menu item leads to the main window used for managing desk administrators 
and trading users. 

- Change party details 

- Add, change and remove administrators 

- Add, change and remove users (traders) 

- Assign users to desks 

- Update desk authorizations 

- Reset passwords of all administrators and users 
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The       button can be used to make new entries (desk administrators and users).  

The        button can be used to edit and amend existing entries (party, desk 
administrators and users). 

Existing entries can be deleted using the        button (desk administrators and users). 

Important: 
New desks can only be entered by SIX Repo Ltd and not by desk administrators 
themselves. 

3.3 CO:RE Reference Data GUI – Trading users 

After logging in as a trading user, the following home page is displayed: 

 



 
 

SIX Repo Ltd 
CO:RE trading platform 

 
 
CO:RE trading platform | Practice Preparatory Examination Documentation for Traders 
08.06.2018 | AMT | srp-trading-practice-en.doc 7 | 40 
 

 

3.3.1 Distribution lists 

A distribution list designates a group of repo participants which can be addressed as 
possible counterparties in bilateral trading 

The Distribution List menu item leads to the main window, which is split into three areas:  

 

1. Distribution Lists 
2. Distribution List Members 
3. Distribution List Member Details 

In area 1 – Distribution Lists – the trading user can: 

- click on the      button to create a new distribution list;  

- click on the       button to update or amend an existing distribution list; or 

- remove a distribution list by clicking on the        button.  

Important: 
Distribution lists that are to be made available in the CO:RE Trading GUI must first be 
configured in the CO:RE Reference Data GUI. A distribution list cannot be configured 
directly in the CO:RE Trading GUI. 

3.3.2 Counterparty agreements 

The counterparty agreements define which parties’ trades can be executed with in the 
CO:RE Trading GUI. 

The Counterparty Agreements menu item leads to the main window:  

1 

2 

3 
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Different counterparty agreements can be created for each market segment and are 
valid for all participants in general. It is not necessary to enter these for each trading 
user individually. 

After selecting the market segment, the trading user can click the        button to enter or 
edit the counterparty agreements. 

  

Counterparty agreements must be configured on a bilateral basis. The Is Mutual 
Agreement column shows if the other party has also created a counterparty 
agreement. 

Important: 
Any changes made in the CO:RE Reference Data GUI are used in the CO:RE Trading GUI. 

Counterparty agreements that are to be made available in the CO:RE Trading GUI must 
first be configured in the CO:RE Reference Data GUI. Counterparty agreements cannot 
be configured directly in the CO:RE Trading GUI. 

Select counterparty 
Remove counterparty 

Select all 
Remove all 
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4.0 CO:RE Trading GUI 

Participants can use the CO:RE Trading GUI to access the CH Repo Market and OTC Spot 
Market of SIX Repo Ltd. This also includes access to the open-market operations and 
standing facilities of the Swiss National Bank (SNB). 

4.1 Set-up of the CO:RE Trading GUI 

4.1.1 General settings 

The Reference menu item can be used to: 

 

1 

2 

 

1. Access detailed information about the contracts and securities available in the CO:RE 
Trading GUI. 

2. Query distribution lists and counterparty agreements which are defined in the CO:RE 
Reference Data GUI. 

 

1. Change between the "Light Color Theme” and “Dark Hi-Contrast Theme”. 

2. Access the Preferences menu, where additional settings can be altered, e.g. colors or 
audio signals. Details of these functions can be found in the online help (see sub-
chapter 4.7 Online help). 

1 

2 
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4.1.2 Create workspaces 

Each trading user can configure their own CO:RE Trading GUI with workspaces, using 
as many workspaces as they require. All the changes are saved and remain on the 
profile of the user. There is no limitation on the number of workspaces. 

A new workspace can be created as follows: 

- via the menu items File > New Workspace 

- by right-clicking in the tabs area  

- by clicking on + in the tabs area 

 

A window then appears, where it is possible to create a workspace and define it in line 
with users’ requirements. 

 

1. Choose a name 

2. Workspace tab color 

3. Icon for the workspace 

4. Layout for the workspace 

4.1.3 Edit workspaces 

Users can right-click on the tab to edit an existing workspace.  

1 2 

3 

4 
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The following elements can be edited: 

- Name of the workspace 

- Workspace tab color 

- Icon 

- The layout of the workspace cannot be changed. 

4.1.4 Add a view to a workspace 

Depending on the layout, one or more views can be added to the newly created 
workspace by right-clicking 

The following views are available: 
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 Shows daily post-trading activity  
 

 

 Shows daily trading activity  
 
 Used by auctioneers for auctions 
 
 Allows participants to participate in auctions 

 
 Is used by participants to take part in bilateral 

trading 

 Is used for settlement status and post-trading 
activities 

 

 Shows trade event notifications for the current 
day 

 Shows executions for various trading modules 
 
 Shows SIX SIS exchange rates 
 
 Shows available collateral and transactions with 

regard to LSFF 
 

 Shows quote limits 
 
 Shows log notifications 
 
 Detailed position list view for collateral by basket 

and currency 
 

 Position summary view by currency 
 
 Shows open transactions 
 
 Allows quoting in the specified area 
 
 Allows quoting in the specified area 
 
 Allows quoting in the specified area 
 

 Shows defined RSS feeds 
 
 Opens an integrated web browser 
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4.1.5 Change size of view 

The workspace views can be adjusted individually by changing the zoom settings in the 
title bar of the individual view. 

 

To change all the views of a workspace at the same time, the slider at the bottom of the 
window can be used. 

 

4.1.6 Arrange and filter columns 

4.1.6.1 Show columns 

Users can click on the small + in the header of the table columns to hide individual 
columns or show additional columns. 

 

4.1.6.2 Arrange and sort columns 

In all views, it is possible to individually change the order of the columns by dragging 
and dropping them. 

Clicking on the header of a column sorts it. A small arrow shows whether it has been 
sorted in ascending or descending order.  

4.1.6.3 Filter columns 

Various filter options can be selected for each column by right-clicking on the header. 
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4.1.7 Master filter 

The master filter defines settings that are applied to all workspaces. This is configured 
via the menu item View > Configure Master Filter. 

Under the default setting, all currencies, terms and baskets are selected to be displayed 
in the workspace.   
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Entries can be added or removed via the tick boxes.  

The  button removes all entries.  

The  button selects all entries. 

The master filter is activated by default; this is indicated via the        icon in the 
workspace. 

Clicking on the icon deactivates/reactivates the master filter for the respective 
workspace.  

4.1.8 Limit Projection View 

The Limit Projection View allows users to configure quoting limits for the trading 
parties based on the party, currency, term, amount and buy/sell indicator. It is 
recommended to only set limits at the party level.  

Limits are only applicable for quotes and allow trades to be automatically generated 
within the limits. The limits are configured via a workspace with the “Limit Projection 
View”.  

After selecting the market segment, the limits can be created/adjusted using the 
                          button. 

 

When configuring a limit for the first time, the structure must be defined up to which 
level the limits are to be shown. The dialog is initiated by clicking on the                             
button. 
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Attributes can be selected in the following window. 

 

It is recommended to only set limits at the party level and to therefore only select this 
point.  

After completing the configuration, the fields appear where the limits can be defined. 

Select item 

Remove item 

Select all 

Remove all 
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The party and the respective limit can be entered. Entries are confirmed by clicking on 
the button        . 

Important: the overall limit must also be entered; this must amount to at least the total 
of all the limits. 

Once all the limits have been entered, the process is concluded by clicking on the 
button                    . 

The Limit Projection View shows all configured limits for the selected market segment. 

 

The Limit Projection View shows the available auto-match limits and the usage of the 
limits over a period of five days. Only the Total column in shown by default. The Value 
Columns menu item can be used to show additional columns. 
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Here the individual columns show the following values: 

Pending 
Quoting transactions that have breached their quoting limits with a certain 
counterparty and must be manually accepted. 

Executed 
Quoting transactions that have been executed today (including transactions that were 
matched based on the user-defined limits)  

Inventory  
Transactions that were settled via SECOM (excl. today’s transactions) 

Total 
Total outstanding volume (executed and inventory) 

4.2 Quoting 

A quote is a general, non-binding offer to buy or sell collateral at a given price. Set-up 
workspaces 

4.2.1 Create a Workspae 

A workspace with the required quoting views must be created. 

 

In the view, the required contracts must then be added in the Market Overview area by 
clicking on the       icon. 
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An existing selection can be amended in the same way. The newly selected contracts 
can:  

- be added to the existing selection 

- replace the existing selection 

- The selected contracts are taken into the Market Overview area. To get an improved 
overview, users can click the        button to hide contracts without quotes. 

 

The columns in the view can be adjusted by clicking on the small +. Users can, for 
example, show the Own Buy Status/Own Sell Status columns in order to compare their 
own quotes in the market with those of other participants.  

It is possible to individually change the order of the columns by dragging and dropping 
them. 

- Columns can be 
sorted 
 

- Multiple items can 
be selected by 
holding down the 
“ctrl” key 
 

- From/to selection 
by holding down 
the shift key 
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4.2.2 Enter quotes 

In the Own Quotes area under Market Overview, it is possible for users to enter the 
details for their own quotes by double-clicking on the Own Buy or Own Sell as well as Buy 
Quantity or Sell Quantity fields. 

 

Quotes entered in this way still then have to be published in the market. This is done by 
either right-clicking on the quote and then selecting Publish Selected Quotes or by 
clicking on the corresponding icon in the menu bar.  

 

Now the quote can be seen by all parties in the Market Overview. 

4.2.3 Amend quotes 

It is possible to amend existing quotes. To do so, users must right-click on the relevant 
quote in the Quote Details area and then select the Amend Quote menu item.  
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Alternatively, they can select the       icon in the menu bar if the quote is marked in the 
Quote Details area. 

It is then possible to make the relevant amendments in the screen that then appears 
and to confirm these by clicking on Send. 

 

4.2.4 Respond to quotes 

Quotes for the same currency (CCY), the same basket (asset) and the same term are 
shown in the same line in the Market Overview. 
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The market depth is shown in the Quote Details window. This shows the details for the 
individual quotes and it is possible to enter an order for a quote. 

 

The Quote Details area is split into Buy (left) and Sell (right).  

To respond to another participant’s quote, the required term has to be selected in the 
Market Overview. In the Quote Details area, it is possible to access the corresponding 
window by right-clicking on the required quote and selecting the Respond to Quote with 
Sell Order / Buy Order menu item. 

 

Alternatively, users can select the  icon in the menu bar if the quote is marked in the 
Quote Details area. 
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On entering a repo order, a binding offer to conclude a trade is sent to the 
counterparty. 

The orders entered are shown in the Orders area in the Quoting view. 

 

4.2.5 Respond to orders for own quotes 

If a counterparty sends an order for a user’s own quote, this also appears in the Orders 
area.  

A right-click opens the context menu, which contains the following options: 

- Take Order 
- Reject Order 
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Alternatively, users can select the corresponding icon in the menu bar if the order is 
marked in the Orders area.  

4.2.5.1 Auto Match 

If an auto-match limit has been configured for a certain counterparty in the Limit 
Projection View (see sub-chapter 4.1.8 Limit Projection View) and a quote results in a 
trade being concluding, limit management comes into effect: 

- If the counterparty limit is not breached, the order is automatically matched. 

- If the limit is breached, the order has to be manually accepted in order to create a 
trade. 

The Auto Match column in the Orders area shows whether the auto-match function 
came into effect.  

 

4.2.6 Delete quotes 

Individual quotes can be deleted in the Quote Details area by right-clicking on the 
corresponding quote and selecting the Cancel Selected Quote item. 
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Alternatively, users can select the  icon in the menu bar if the quote is marked in the 
Quote Details area.  

If more than one quote has to be deleted, the following options are available: 

 

a. Delete all quotes for a term 
Right-click on the relevant term and select the Cancel All Quotes for Selected Rows 
menu item. 

b. Delete all quotes for a market segment 
Right-click on any term in the relevant market segment and select the Cancel All 
Quotes on Selected Market Segment menu item. 

b 

a 
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4.3 Bilateral trading 

With bilateral trading, it is possible to trade with certain counterparties in the Repo 
Market and the OTC Spot Market. 

4.3.1 Set-up workspaces 

A workspace with the Bilateral Trading View must be created. This view is split into the 
Initiation and Negotiation areas. Both the OTC Spot Market and the Repo Market are 
shown. 

 

Orders and offers are sent in the Initiation area, which also shows which orders have 
been issued or received with the corresponding status. 

Orders and offers are negotiated and concluded in the Negotiation area. The details 
shown in the Negotiation area refer to offers and orders that were selected in the 
Initiation area. 

Important: 
A trade is only possible with a counterparty for which a counterparty agreement has 
been created in the CO:RE Reference Data GUI in advance. 

4.3.2 Repo request offer 

A request offer is an invitation to trade sent to a qualified group of recipients (defined 
via a distribution list) or a certain counterparty. The default setting is All Parties and 
covers all counterparties for which a counterparty agreement is in place. 

Initiation 

Negotiation 
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4.3.2.1 Enter new repo request offer 

The window used to enter a new repo request offer is opened by right-clicking in the 
Initiation area and then selecting New Repo Request Offer or by clicking on the 
corresponding icon in the menu bar. 

 

The following entries are mandatory in the window for entering the repo request offer: 

- Currency 
- Term 
- Basket 
- Distribution list or counterparty 
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The other fields are optional and can be used to enter additional parameters for the 
transactions. However, certain values are automatically entered by the system 
depending on the traded instrument. 

4.3.2.2 Negotiate repo request offers 

Incoming repo request offers from other parties are shown in the Initiation area of the 
Bilateral Trading View.  

To respond to a request offer, users must right-click on the relevant entry to open the 
corresponding context menu. 



 
 

SIX Repo Ltd 
CO:RE trading platform 

 
 
CO:RE trading platform | Practice Preparatory Examination Documentation for Traders 
08.06.2018 | AMT | srp-trading-practice-en.doc 29 | 40 
 

 

 

The following options are available: 

a. Order Response to Request Offer 

A response to the request offer is sent to the counterparty in the form of an order, i.e. a 
binding addressed offer is made. 

Alternatively, users can select the       icon in the menu bar.  

In the Repo Order Response to Request Offer window, it is possible to add the attributes 
not completed by the counterparty and to adjust the following values before the order 
is sent: 

- Repo Rate 
- Cash Amount 
- Minimal Size 
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b. Quote Response to Request Offer 

A response to the request offer is sent to the counterparty in the form of a quote, i.e. an 
amended quote is sent to the counterparty. 

Alternatively, users can select the       icon in the menu bar.  

In the Repo Quote Response to Request Offer window, it is possible to adjust the following 
attributes before the quote is sent: 

- Repo Rate 
- Quantity 
- Minimal Size 
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After responding to the request offer, the status in the Initiation area of the Bilateral 
Trading View changes to Replied (Order Response) or Countered (Quote Response). The 
details can be viewed in the Negotiation area. To do so, the corresponding offer in the 
Initiation area must be selected.  

 

An order response must still be accepted by the counterparty by means of a take order 
for the trade to materialize. However, the counterparty can also reject it. 
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The counterparty must in turn respond to the quote response with an order response. 

4.3.3 Repo order 

A repo order is an addressed offer, a binding offer to conclude a transaction sent to an 
individual selected counterparty. In such cases, no distribution list is used. 

4.3.3.1 Enter new repo order 

The window used to enter a new repo order offer is opened by right-clicking in the 
Initiation area and then selecting New Repo Order or by clicking on the corresponding 
icon in the menu bar. 

 

The following entries are mandatory in the window for entering the repo order: 

- Market Segment 
- Buy/Sell 
- Currency 
- Term 
- Basket 
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- Traded Amount 
- Counterparty 

 

The other fields are optional and can be used to enter additional parameters for the 
transactions.  

4.3.3.2 Accept received repo order 

Incoming repo orders from other parties are shown in the Initiation area of the Bilateral 
Trading View. If a repo order is selected, the details can be seen in the Negotiation area. 

 

To respond to a repo order, users must right-
click on the relevant entry in the Negotiation 
area to open the corresponding context menu. 

 

 



 
 

SIX Repo Ltd 
CO:RE trading platform 

 
 
CO:RE trading platform | Practice Preparatory Examination Documentation for Traders 
08.06.2018 | AMT | srp-trading-practice-en.doc 34 | 40 
 

 

The following options are available a received repo orders: 

Counter Order 
The order is accepted with certain changes  

Take Order  
The order is accepted. 

Reject Order 
The order is rejected. 

 

 

Alternatively, the options can be selected by clicking on the respective icon in the menu 
bar if the order is marked. 

If a response to a repo order is sent in the form of a counter order, the counterparty 
must in turn respond to this with a take order notification. 

Repo orders accepted by one party by means of a take order appear straightaway with 
the status ENDED in the Initiation are or FULLY MATCHED in the Negotiation area. 
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4.3.4 Templates 

To simplify the offer/order entry processes, templates can be created. To do so, click on 
the green + sign at the bottom of the relevant entry window after entering the relevant 
fields. 

 

The template is created after entering a name and a key combination. When entering a 
new offer/new order, this can be accessed by either using the key combination or 
selecting the relevant template in the drop-down menu and clicking the button        . 

4.3.5 Conversation History 

To show all incoming and outgoing notifications for a bilateral trade, right-click on the 
respective order in the Negotiation area and select the Show Conversation History in the 
context menu. 

  

Alternatively, users can select the        icon in the menu bar if the order is marked in the 
Negotiation area.  

4.4 Executions View 

All own transactions concluded on the current date can be seen in the Executions View. 
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4.4.1 Show Trade Slip 

To show the trade slip for a transaction, right-click on the respective order and select 
the Market Trade Slip in the context menu. 

 

Alternatively, users can select the       icon in the menu bar if the relevant order is 
marked.  
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4.5 Auctions Overview 

The Auctions Overview shows all auctions in which the participant can take part. 

 

4.5.1 Participating in an auction 

To take part in an auction, the Send Auction Order point can be selected by right-clicking 
on the auction. Alternatively, users can select the       icon in the menu bar. 

 

The participant must enter the price and amount (Security Size) in the New OTC SPOT 
Auction Order window (if the auctioneer has not entered a value) or only the amount if 
the auctioneer has specified a price. 
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The auction orders entered by the participant are shown in the Auction Overview View 
under Own Orders. 

 

4.5.2 Deleting Auction Orders 

The participant can delete orders unless they have "Initiated” status. To do so, they 
must right-click on the order and then select Cancel Order. 
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Alternatively, users must select the relevant icon in the menu bar in the Own Orders 
area if the order is marked. 

4.6 Contract Inventory 

The Contract Inventory view shows the current status of the concluded repo trades. 
Trades can also be modified or canceled. 

Repo trades that have "Closed" status after repurchase are no longer displayed in the 
Contract Inventory view. No trade history is available; this can be set up and obtained 
from SIX Repo Ltd via reports.  

4.7 Online help 

This document only describes the most important views and functions. If you require 
more information, please consult the online help, which can be accessed in any view via 
the help icon. 

 

Alternatively, users can access the online help via the Help > Online Help menu item. 
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